A task is an item that you create in Outlook to track until its completion. A to-do item is any Outlook item — such as a
task, an e-mail message, or a contact — that has been flagged for follow-up. By default, all tasks are flagged for
follow-up when they are created, even if they have no start date or due date. Therefore, whenever you create a task,
or flag an e-mail message or a contact, a to-do item is created automatically.

When you need to quickly indicate that an item requires your attention at a later time, flagging is the best option.
When you flag an item, it is displayed with a flag in the Mail view, in Tasks, in the To-Do Bar, and in the Daily Task
List in Calendar. Flagging a message or contact does not create a new task. Because the to-do item is still an e-mail
message or contact after being flagged, you do not have the ability to assign it as a task to someone else, or indicate
its progress or percentage of completeness.

A task can occur once or repeatedly. A recurring task can repeat at regular intervals, or it can repeat based on the
date that you mark the task complete. For example, you can create a recurring task to send a status report to your
manager on the last Friday of every month, or create a recurring task to get a haircut one month after your last one.
Both tasks and to-do items appear in Tasks, in the To-Do-Bar, and in the Daily Task List in Calendar. No matter
which view you are in, the To-Do Bar keeps you informed of your calendar, task, and to-do items.

There are several ways to create a new task in Outlook. You can use the Task command (click New on

the File menu), enter a task in the Type a new task text box in the To-Do Bar from any view in Outlook, type in any
blank space in the Daily Task List in Calendar, or click and type in the Click here to add a new Task text box at the
top of Tasks view. Of these, the fastest way is to use the To-Do Bar.

You can also create a task by dragging an item, such as an e-mail message, to Tasks in the Navigation Pane. A
copy of the e-mail message is then created as a task.

Whether you track tasks that are assigned to yourself (such as reminders to respond to e-mail messages), or track
tasks that are assigned to other people (such as the progress of someone's project), Outlook tasks are your solution.
You can quickly add and update tasks, or mark them as complete. With tasks incorporated into the Calendar view,
you have a rich interface for keeping track not only of your appointments, but of the tasks that you need to complete
on a given day as well.
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Create a task from the File menu

On the File menu, point to New, and then click Task.

Keyboard shortcut To create a new task, press CTRL+SHIFT+K.

In the Subject box, type a name for the task.

NOTE You have now entered enough information to create a task. The following steps are optional, but will help

you better manage your tasks in Outlook.
On the Task tab, in the Actions group, click Save & Close or continue with the following steps to customize
your task.

If you want, set the Start date and the Due date for the task.
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If you specify a Start date, the Due date field is automatically set to the same day. You can change the Due
date field to any date that you want.

If you want to make the task recur, on the Task tab, in the Options group, click Recurrence.

In the Task Recurrence dialog box, click the frequency (Daily, Weekly,Monthly or Yearly) with which the task

should recur, and then do one of the following:

Make the task recur based on a regular interval In the Recurrence pattern section, select the options for
the frequency interval that you want. Do not select Regenerate new task, or the task will not recur at regular
intervals.

Make the task recur based on completion date  Select Regenerate new task, and in the box, type the
amount of time after which a new task must be generated.

Each time that you mark the task complete, a new task will be created based on your specifications.

TIP This is your best choice when you do not want the next reminder for a task to appear until the previous one is
marked as complete. If you do not mark the item complete, the next reminder will never appear. For example, if you
have a reminder to pay your utility bill on the 15th of each month and you do not mark the occurrence on April 15th as
complete, in May you will still see the not yet completed April 15th task. Only after you mark the April 15th task as
complete does the May 15th occurrence of the task appear.

Click OK to close the Task Recurrence dialog box.

If you want to add a reminder alert, select the Reminder check box, and then enter the date and time for the

reminder.

You can specify a custom sound to be played with your reminder. Click *H?, click Browse, select the sound file to
play, click Open, and then click OK. This changes the reminder sound only for this task.

If you want to track your progress on this task, in the Status, Priority, and % Complete boxes, enter the values
that you want.

The Status and % Complete fields are linked. When you change the value in either field, the value in the other field
changes accordingly.

STATUS % COMPLETE
Not Started 0

In Progress 1-99
Completed 100

Waiting on someone else 0-100
Deferred 0-100

If you want to assign a color category to your task, on the Task tab, in the Options group, click Categorize, and
then click one of the color categories on the menu. For more color categories, click All Categories.

The first time that you use a color category, you are prompted to provide a name for the color category that is more
meaningful to you. You can create custom color categories, associate custom colors with the color categories, and
assign shortcut keys to the color categories. Click OK to return to the Task window.
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TIP Changed your mind about a color category assignment? Right-click the color or name of the color category,
and then click Clear Name of Category or Clear All Categories.

If your task involves a person or organization in your Contacts, you can create a quick link to the contact, by
clicking Contacts at the bottom of the window, and then selecting an entry. Click OK to close the Select Contacts
dialog box.

NOTE By default, Contacts linking does not appear on the message, contacts, and tasks windows. To turn on

Contact linking, on the Task tab, in the Actions group, click Save & Close. On the main Outlook window, on
the Tools menu, click Options. On the Preferences tab, click Contact Options, and then on the Contact
Options dialog box under Contact Linking, select the Show Contact Linking on all Forms check box. Open your
task to continue with this procedure.
If you do not want other people to see a shared task entry, on the Task tab, in the Options group, click Private.

If you want to enter mileage, work hours, and other billing information, on the Task tab, in the Show group,
click Details. Type the information in theTotal work, Actual work, Mileage, and Billing information text boxes.

On the Task tab, in the Actions group, click Save and Close.
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Create a task or a to-do item from an e-mail
message

There are several ways to turn an e-mail message into a task or a to-do item.

Do any of the following:
Flag an e-mail message for follow-up

Flagging a message is the best option when you need to quickly mark an item for your attention at a later time. When
you flag an item, it is displayed in the Mail view with a flag, in Tasks, in the To-Do Bar, and in the Daily Task List in
Calendar. Flagging a message or contact does not create a new task. Because the to-do item still remains an e-mail
message or contact after being flagged, you do not have the ability to assign it as a task to someone else, or indicate
its progress or percentage of completeness.

1. In Mail, right-click the flag column for an e-mail message.
2. Choose the due date.

TIP To add a follow-up flag quickly, click the flag column next to the e-mail message. A start date and due date of

today are set automatically.

NOTE To change the reminder time, reminder sound, Start date, Due date, or the flag text that appears in the
InfoBar, or to clear the reminder flag, right-click the flag column next to the e-mail message, and then
click Custom or Add Reminder. Both options open the same dialog box, but when you use Add Reminder, the

reminder check box is selected automatically.
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Drag an e-mail message to the To-Do Bar to create a to-do item

The To-Do Bar must be arranged by Start Date or Due date to use these procedures.
1. Click an e-mail message to select it, and then drag the message to the task list section of the To-Do Bar.

2. When you see a red line with arrows at each end positioned where you want to place the task, release the
mouse button.

Arranged By: Due Date |
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Drag an e-mail message to the Tasks button to create a new task

When you drag an e-mail message to Tasks in the Navigation Pane, you can use all of the features of a task item,
and the contents of the e-mail message, except attachments, are copied to the body of the task. Even if the original
e-mail message is later deleted, the task, including the copied contents, except attachments, of the e-mail message,
is still available.

1. Click an e-mail message to select it, and then drag it to the Task button on the Navigation Pane.

TIP To add the message as an attachment to the task instead of pasting the text into the task body, right-click the
message and drag it to the task list. On the shortcut menu, click Copy Here as Task with Attachment.

A new task item window appears, and a copy of the e-mail contents is pasted into the task body. The subject of the e-
mail message becomes the subject of the task. If you want, you can change the subject.

NOTE You have now entered enough information to create a task. The following steps are optional, but will help

you better manage your tasks in Outlook.



2. On the Task tab, in the Actions group, click Save & Close or continue with the following steps to customize
your task.

3. If you want, set the Start date and the Due date for the task.

If you specify a Start date, the Due date field is automatically set for the same day. You can change the Due date to
a date that you want.

4, If you want to make the task recur, on the Task tab, in the Options group, click Recurrence.

5. In the Task Recurrence dialog box, click the frequency (Daily, Weekly, Monthly or Yearly) with which the
task should recur, and then do one of the following:

e Make the task recur at regular intervals  In the Recurrence pattern section, select the options for the
frequency interval that you want. Do not select Regenerate new taskor the task will not recur at regular
intervals.

e Make the task recur based on completion date  Select Regenerate new task, and in the box, type the
amount of time after which a new task must be generated.

Each time you mark the task complete, a new task will be created based upon your selections.

TIP This is your best choice when you do not want the next reminder for a task to appear until the previous one is

marked complete. If you do not mark the item complete, the next reminder will never appear. For example, if you
have a reminder to pay your utility bill on the 15th of each month and you do not mark the occurrence on April 15th as
complete, in May you will still see the April 15th task. Once you mark the April 15th task complete, the May 15th
occurrence of the task will appear.

6. Click OK to close the Task Recurrence dialog box.

7. If you want to add a reminder, select the Reminder check box to turn on a reminder alert. Enter the date

and time you want for the reminder.

8. You can specify a custom sound to be played with your reminder. Click *E'f, click Browse, select the sound
file to play, click Open, and then click OK. This changes the reminder sound only for this task.

9. If you want to track your progress on this task, in the Status, Priority, and % Complete boxes type or select
the options you want.

The Status and % Complete fields are dependent on each other. By changing the value in one field, the value in the

other field changes accordingly.

STATUS % COMPLETE
Not Started 0
In Progress 1-99
Completed 100
Waiting on someone else 0-100
Deferred 0-100
10. If you want to assign a color category to your task, on the Task tab, in the Options group, click Categorize,

and then click one of the entries from the menu. For more color categories, click All Categories.



The first time you use a color category, you will be prompted to provide a name that is more meaningful to you. You
can create custom color categories, associate custom colors with color categories, and assign shortcut keys.
Click OK to return to the Task window.

TIP Changed your mind about a color category assignment? Right-click the color or name of the color category,
and then click Clear Name of Category or Clear All Categories.
11. If your task involves a person or organization in your Contacts, you can create a quick link to the contact, by
clicking Contacts at the bottom of the window, and then selecting an entry. Click OK to close the Select
Contacts dialog box.

12. If you do not want other people to see a shared task entry, on the Task tab, in the Options group,
click Private.
13. If you want to enter mileage, work hours, and other billing information, on the Task tab, in the Show group,

click Details. Type the information in the Total work, Actual work, Mileage, and Billing information text
boxes.

14. On the Task tab, in the Save group, click Save and Close.
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Create a to-do item from a contact

Flagging a contact is the best option when you need to quickly mark a contact for your attention at a later time.
Flagging a contact creates a to-do item, with the text of the flag in the InfoBar. The flagged contact it is also displayed
in the Tasks list, To-Do Bar, and in the Calendar Daily Task List. Flagging a contact does not create a new task item.
Because the to-do item still remains a contact, you do not have the ability to assign it as a task to someone else, or to
indicate its progress or percentage complete.

In Contacts, right-click the contact.
Point to Follow Up on the shortcut menu, and then click the due date.

TIP To change the reminder time, reminder sound, Start date, Due date, or the flag text that appears in the InfoBar,

or to clear the reminder flag, click Custom or Add Reminder. (Both options open the same dialog box, but when you
use Add Reminder, the reminder check box is selected automatically.)
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Create a task in the To-Do Bar

The To-Do Bar appears in all Outlook views by default. You can turn the To-Do Bar on or off. In addition, you can
choose to display a minimized version of the To-Do Bar, which uses less screen space. When you turn the To-Do Bar
on or off, or minimize it in a specific view, the setting applies only to that view. For example, if you turn off the To-Do
Bar in the Mail view, it will remain off each time you are in the Mail view, including the next time you start Outlook.
However, it remains on in other views such as Calendar, Notes and Tasks.

To toggle the To-Do bar on or off, click View, point to To-Do Bar, and then click Normal, Minimized, or Off.
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To create a new task in the To-Do Bar, click in the Type a new task text box (called the Task Input Panel, type a
subject for the task, and then press ENTER.

Arranged By: Due Date Today on top |"lL

Type a new task Il

By default, the task will be assigned a due date and a start date that are based upon the flag's Set Quick

Click setting. When you first install Outlook, this setting is configured as Today.

If you create a task and change the flag to another Due date choice, any future tasks that you enter in the To-Do Bar
will use the new setting. You can always override the choice that is displayed and pick another option. However,
when you restart Outlook, the first task entered will default to the Set Quick Click flag setting.

TIP To change the default flag setting, right-click the flag column in any view, click Set Quick Click, and then

choose the flag setting that you want. The options include No Date. Choosing the No Date flag makes the item

appear in the No Date group in the To-Do Bar.
NOTE You have now entered enough information to create a task. The following steps are optional, but will help

you better manage your tasks in Outlook.
Continue with the following steps to customize your task by double-clicking the task in the To-Do Bar.

If you want, set the Start date and the Due date for the task.

If you specify a Start date, the Due date field is automatically set for the same day. You can change the Due date to

a date that you want.

If you want to make the task recur, on the Task tab, in the Options group, click Recurrence.

In the Task Recurrence dialog box, click the frequency (Daily, Weekly, Monthly or Yearly) with which the task

should recur, and then do one of the following:

e Make the task recur at regular intervals  In the Recurrence pattern section, select the options for the
frequency interval that you want. Do not select Regenerate new task or the task will not recur at regular

intervals.

e Make the task recur based on completion date  Select Regenerate new task, and in the box, type the

amount of time after which a new task must be generated.
Each time you mark the task complete, a new task will be created based upon your selections.

TIP This is your best choice when you do not want the next reminder for a task to appear until the previous one is
marked complete. If you do not mark the item complete, the next reminder will never appear. For example, if you
have a reminder to pay your utility bill on the 15th of each month and you do not mark the occurrence on April 15th as
complete, in May you will still see the April 15th task. Once you mark the April 15th task complete, the May 15th
occurrence of the task will appear.

Click OK to close the Task Recurrence dialog box.

If you want to add a reminder, select the Reminder check box to turn on a reminder alert. Enter the date and

time you want for the reminder.

You can specify a custom sound to be played with your reminder. Click @5, click Browse, select the sound file to
play, click Open, and then click OK. This changes the reminder sound only for this task.
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If you want to track your progress on this task, in the Status, Priority, and % Complete boxes type or select the
options you want.

The Status and % Complete fields are dependent on each other. By changing the value in one field, the value in the
other field changes accordingly.

STATUS % COMPLETE
Not Started 0

In Progress 1-99
Completed 100

Waiting on someone else 0-100
Deferred 0-100

If you want to assign a color category to your task, on the Task tab, in the Options group, click Categorize, and
then click one of the entries from the menu. For more color categories, click All Categories.

The first time you use a color category, you will be prompted to provide a name that is more meaningful to you. You
can create custom color categories, associate custom colors with color categories, and assign shortcut keys.
Click OK to return to the Task window.

TIP Changed your mind about a color category assignment? Right-click the color or namef the color category, and
then click Clear Name of Category or Clear All Categories.
If your task involves a person or organization in your Contacts, you can create a quick link to the contact, by
clicking Contacts at the bottom of the window, and then selecting an entry. Click OK to close the Select Contacts

dialog box.
If you do not want other people to see a shared task entry, on the Task tab, in the Options group, click Private.

If you want to enter mileage, work hours, and other billing information, on the Task tab, in the Show group,
click Details. Type the information in the Total work, Actual work, Mileage, and Billing information text boxes.

On the Task tab, in the Save group, click Save and Close.

TIP To move a task up or down on the list, click and drag the item to the position that you want. As you drag the

task, a red line with arrows indicates where the task will be placed when you release the mouse button.
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Create a task in the Daily Task List in Calendar

The Daily Task List appears only in the Outlook Calendar day and week views. To toggle the Daily Task List on or off,
in Calendar, click View, point to Daily Task List, and then click Normal, Minimized, or Off.

Show tasks on: Due Date

@ V| callbank.. | Make hotel... ([
: ) V| Pickup dry.. %
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Order new ...
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To display only the total number of tasks, do one of the following:

In Calendar, click View, point to Daily Task List, and then click Minimized.
t
Point to the top edge of the Daily Task List. When the pointer becomes a =¥, drag the edge to the bottom of the

window.

TIP To create new tasks in the Daily Task List, you must use the Normal Daily Task List setting.

In the Daily Task List, as your pointer hovers, Click to add task is displayed.
Click any blank space beneath a day column.
Type a subject for the task, and then press ENTER.

By default, the task will be assigned a Start date and Due date of the day in the column above the Daily Task List. To
change the Start date or Due date of the task, drag the created task to the day that the task is due. Instead of
dragging the task, you can open the task and then change the start and due dates. To do so, you can right-click the
task, and then click Open, or select the item, press ESC, and then press ENTER.

If you want to make the task recur, on the Task tab, in the Options group, click Recurrence.

In the Task Recurrence dialog box, click the frequency (Daily, Weekly, Monthly or Yearly) with which the task

should recur, and then do one of the following:

e Make the task recur at regular intervals In the Recurrence pattern section, select the options for the
frequency interval that you want. Do not select Regenerate new task or the task will not recur at regular
intervals.

e Make the task recur based on completion date  Select Regenerate new task, and in the box, type the

amount of time after which a new task must be generated.
Each time you mark the task complete, a new task will be created based upon your selections.

TIP This is your best choice when you do not want the next reminder for a task to appear until the previous one is
marked complete. If you do not mark the item complete, the next reminder will never appear. For example, if you
have a reminder to pay your utility bill on the 15th of each month and you do not mark the occurrence on April 15th as
complete, in May you will still see the April 15th task. Once you mark the April 15th task complete, the May 15th
occurrence of the task will appear.

Click OK to close the Task Recurrence dialog box.

If you want to add a reminder, select the Reminder check box to turn on a reminder alert. Enter the date and
time you want for the reminder.

You can specify a custom sound to be played with your reminder. Click «HE, click Browse, select the sound file to
play, click Open, and then click OK. This changes the reminder sound only for this task.

If you want to track your progress on this task, in the Status, Priority, and % Complete boxes type or select the
options you want.

The Status and % Complete fields are dependent on each other. By changing the value in one field, the value in the

other field changes accordingly.
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STATUS % COMPLETE

Not Started 0

In Progress 1-99
Completed 100
Waiting on someone else 0-100
Deferred 0-100

If you want to assign a color category to your task, on the Task tab, in the Options group, click Categorize, and
then click one of the entries from the menu. For more color categories, click All Categories.

The first time you use a color category, you will be prompted to provide a name that is more meaningful to you. You
can create custom color categories, associate custom colors with color categories, and assign shortcut keys.
Click OK to return to the Task window.

TIP Changed your mind about a color category assignment? Right-click the color or name of the color category,

and then click Clear Name of Category or Clear All Categories.

If your task involves a person or organization in your Contacts, you can create a quick link to the contact, by
clicking Contacts at the bottom of the window, and then selecting an entry. Click OK to close the Select Contacts
dialog box.

If you do not want other people to see a shared task entry, on the Task tab, in the Options group, click Private.

If you want to enter mileage, work hours, and other billing information, on the Task tab, in the Show group,
click Details. Type the information in the Total work, Actual work, Mileage, and Billing information text boxes.

On the Task tab, in the Save group, click Save and Close.

TIP To move a task up or down on the list, click and drag the item to the position that you want. As you drag the

task, a red line with arrows indicates where the task will be placed when you release the mouse button.
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